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ute doar porţiunile din cuvintele respective care nu conţin diacritice. De
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2.4 Georeferenţierea pe baza punctelor comune (2) . . . . . . . . . . 37

3 Transformarea coordonatelor ı̂n diferite sisteme de proiecţie 47
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Capitolul 1

Noţiuni teoretice. Concepte

1.1 GIS

Termenul de GIS este acronimul pentru Geographic Information System, care
adaptat ı̂n limba română ı̂şi găseşte corespondenţa ı̂n SIG, respectiv Sistem In-
formatic Geografic.
Aceste sisteme reprezintă o suită de unelte informatice care permit analiza da-
telor spaţiale. În general acestea nu se rezumă la o singură aplicaţie software ci
conţin mai multe componente, atât hardware cât şi programe de calculator.
Caracteristica esenţială a acestor sisteme este aceea că informaţia pe care o
manipulează se referă la locuri precise de pe suprafaţa terestră. Datele ast-
fel indexate constituie reprezentări digitale, simplificate, ale elementelor de pe
suprafaţa Pământului [Neteler and Mitasova, 2008]. Codificarea internă a aces-
tor localizări se realizează prin georeferenţiere, adică prin raportarea la un sistem
de coordonate [Bonham-Carter, 1994].

1.1.1 Modele de date spaţiale

După cum s-a afirmat anterior, informaţia dintr-un sistem informatic geografic
reprezintă o versiune simplificată şi convenţionlă a realităţii. Există două mo-
dele de date prin care se pot reprezenta convenţional obiectele reale: modelul
de date raster şi modelul de date vector.

Modelul de date raster

Este un model de date ı̂n care informaţia este reprezentată sub forma unei
matrici de pixeli, ı̂n care fiecare pixel are una sau mai multe valori numerice
(fig. 1.2). Aceste numere pot fi valori ale unor parametri fizici (temperatură,
altitudine, concentraţii chimice), caz ı̂n care matricea reprezintă o distribuţie
spaţială a acelui parametru. De asemenea, unui pixel ı̂i pot corespunde mai
multe valori, ca ı̂n cazul imaginilor color (fie scanate, fie fotografii), ı̂n care
fiecărui pixel ı̂i corespund trei valori care exprimă intensitatea celor trei culori
fundamentale (roşu, albastru şi verde), pe o scară de la 1 la 255. În felul acesta
se poate compune tot spectrul de culori care apare pe o imagine.
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Unitatea fundamentală a acestui model de date este pixelul. Acesta are, de
cele mai multe ori, forma unui pătrat, dar poate apărea şi sub forma unui
dreptunghi, ı̂n anumite aplicaţii. Într-o imagine georeferenţiată mărimea laturii
fiecărui pixel se măsoară ı̂n unităţile sistemului de coordonate (metri, grade,
etc.) şi exprimă rezoluţia imaginii. Cu cât aceasta este mai mică cu atât pixelul
mediază informaţia de pe o suprafaţă mai mică şi deci imaginea devine mai
detaliată (fig. 1.1). Într-o imagine (ortofotoplan, sau imagine satelitară) cu cât
rezoluţia este mai mică, cu atât se pot distinge mai multe obiecte (copaci, clădiri,
oameni). În prezent se pot obţine imagini satelitare cu rezoluţii ı̂ntre 0.82 m
(imagini Ikonos1 disponibile contra cost) şi 30 m (imagini Landsat2 disponibile
gratuit).

Fig. 1.1: Rezoluţia unui set de date raster: cu cât mărimea laturii pixelului este
mai mare, cu atât detaliile pe care le suprinde sunt mai puţine. În figură este
reprezentat un model numeric altitudinal la rezoluţii diferite: a) 20 m; b) 60 m;
c) 100 m; d) 200 m. Fiecare pixel are o valoare de altitudine. Sursa [Terente,
2008]

În cazul nostru, folosind imagini scanate (hărţi, planuri), avem de-a face cu
modele de date raster. Este mai puţin important câte valori primeşte fiecare
pixel3, important este de reţinut că imaginile sunt matrici de pixeli pătraţi şi,
mai mult, pentru a se distinge pixelii unul de altul, imaginile conţin un sistem
de coordonate intern. Pixelii sunt identificaţi astfel ı̂n funcţie de linia şi coloana
pe care apar ı̂n imagine. Liniile se numerotează de sus ı̂n jos, iar coloanele de
la stânga la dreapta, rezultând astfel că primul pixel se află ı̂n colţul din stânga
sus, iar ultimul ı̂n colţul din dreapta jos.

1http://www.geoeye.com/CorpSite/products/imagery-sources/Default.aspx
2http://landsat.gsfc.nasa.gov
3trei, dacă imaginea este color şi una, dacă imaginea este alb-negru sau ı̂n tonuri de gri
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Fig. 1.2: Modelul de date raster: Fiecare pixel al imaginii, o hartă scanată,
conţine informaţie pentru cantitatea de culoare cu care să fie reprezentat. Pen-
tru afişarea pe monitoare se foloseşte schema RGB (Red-Green-Blue) ı̂n care
fiecare culoare se compune din ”cantităţi” diferite ale fiecărei culori fundamen-
tale (Roşu-Verde-Albastru), pe o scară de la 1 la 255. În figură, se arată valorile
pixelilor, pe canalul Albastru, din zona marcată.

Utilizat pentru a reprezenta imagini scanate, acest model de date nu este foarte
eficient, deoarece nu permite distingerea elementelor reprezentate pe hartă (dru-
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muri, localităţi, parcele, râuri, etc). Este nevoie de o digitizare a hărţii scanate
pentru ca fiecare element să devină obiect individual şi să poată fi manipu-
lat. Modelul devine foarte util atunci când se foloseşte pentru reprezentarea
distribuţiei spaţiale a unor fenomene naturale sau culturale (temperatură, den-
sităţi de populaţie, altitudini, concentraţii chimice ale unor poluanţi, etc.). Se
pot realiza diferite operaţii matematice ı̂ntre matrici care se suprapun spaţial,
ı̂n felul acesta obţinându-se informaţii noi (de exemplu, panta se poate calcula
doar pe baza modelului numeric altitudinal, care este o matrice cu altitudini
pentru o anumită regiune).

Modelul de date vector

Acest model se foloseşte pentru extragerea informaţiilor de pe hărţile scanate şi
georeferenţiate, sau de pe alte surse raster (imagini satelitare, ortofotoplanuri,
etc). Este un model ı̂n care elementul fundamental este vertexul. Acesta este
un punct definit printr-o pereche de coordonate ı̂n sistemul de coordonate ı̂n
care se lucrează, este adimensional şi de aceea nu ı̂şi schimbă aspectul indiferent
de nivelul de zoom. Pornind de la acest element se pot compune toate obiectele
care apar pe o hartă astfel:

• obiectele punctiforme (vârfuri, poduri, arbori izolaţi, sau, depinzând de
scara reprezentării, localităţi, case, etc) se reprezintă prin vertecşi;

• obiectele liniare (râuri, drumuri, căi ferate, etc) se reprezintă prin linii
poligonale (frânte ı̂n punctele de inflexiune, care sunt vertcşi);

• obiectele areale (parcele, localităţi, zone cu diferite utilizări ale terenurilor,
situri diverse, etc) se reprezintă prin poligoane (care sunt de fapt liniile
poligonale descrise anterior, ı̂nchise).

Avantajul acestui model este că permite extragerea elementelor de pe hartă care
devin astfel obiecte digitale unice (datorită poziţiei unice pe care o au ı̂n spaţiu)
cărora li se pot asocia atribute. În felul acesta se pot constitui baze de date
spaţiale cu elemente bine individualizate.
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1.2 Proiecţia şi sistemul de coordonate

Faptul că Pământul are o formă neregulată, aproximativ sferică, face ca defini-
rea unui sistem de coordonate potrivit să fie destul de complexă. Acesta trebuie
să fie definit fie pe o sferă sau un elipsoid, determinând un sistem de coordonate
geografice (latitudine şi longitudine), fie pe o proiecţie a suprafeţei terestre care
poate fi desfăşurată ı̂n plan şi pe care se poate defini un sistem de coordonate
carteziene (X, Y şi Z) [Neteler and Mitasova, 2008].

1.2.1 Principii

Forma Pământului

Forma Pământului este aproximată printr-un model matematic reprezentat printr-
un elipsoid. Se consideră că, datorită mişcării de rotaţie a Pământului ı̂n jurul
axei polilor, forma sa este mai bombată la ecuator şi mai turtită la poli, adică
ı̂n secţiune nu apare ca un cerc ci ca o elipsă. Elipsoidul este forma tridimensio-
nală obţinută prin rotirea unei elipse ı̂n jurului axei sale mari (fig. 1.3). De-a
lungul timpului s-a elaborat o varietate de elipsoizi care asigurau cea mai bună
potrivire cu suprafaţa reală, terestră, ı̂n diferite regiuni ale lumii. Aceştia au
primit denumiri ı̂n funcţie, de obicei, de matematicienii care i-au elaborat. De
exemplu: Clarke 1866, folosit ı̂n America de Nord, Bessel 1841, folosit ı̂n Eu-
ropa, Krassowsky 1940, pentru Federaţia Rusă.

Fig. 1.3: Aproximarea formei Pământului printr-un elipsoid: mai bombat la
ecuator şi mai turtit la poli. Imaginea (uşor deformată pentru a fi mai sugestivă)
este preluată de pe Google Earth (http://earth.google.com/), ı̂n care Pământul
este reprezentat prin elipsoidul WGS84

Un alt model de reprezentare a suprafeţei terestre este geoidul. Aceasta este o
formă geometrică tridimensională complexă ce reprezintă o suprafaţă de echipotenţial
gravitaţional. Ea poate fi asimilată suprafeţei Oceanului Planetar, neafectată
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de procese dinamice precum curenţi, valuri, maree, expansiune termică, etc,
supusă doar acţiunii gravitaţiei. Deoarece este o suprafaţă pe care gravitaţia
se menţine constantă, geoidul ”ondulează” ı̂n funcţie de variaţiile de masă ale
litosferei (fig. 1.4).
Aproximarea formei Pământului printr-un elipsoid este suficientă pentru poziţionarea
orizontală. Pentru determinarea cu mare acurateţe a altitudinilor se foloseşte
ca referinţă suprafaţa geoidului [Neteler and Mitasova, 2008].

Fig. 1.4: Geoidul ca suprafaţă de referinţă pentru determinarea altitudini-
lor: Gravitaţia nu acţionează uniform pe suprafaţa terestră. Ea variază ı̂n
funcţie de masa scoarţei terestre. Sub continente, unde scoarţa terestră e
groasă, geoidul se află la o distanţă mai mare faţă de centrul Pământului. In-
vers, sub oceane, unde scoarţa terestră e subţire, geoidul se află la o distanţă
mai mică şi prezintă ”depresiuni”, ca ı̂n imagine, ı̂n Oceanul Indian. Sursa:
http://www.dirkhartwich.com/sat2/koordinaten.html

Între cele trei suprafeţe: elipsoidul, geoidul şi suprafaţa terestră reală există
diferenţe de poziţie ca ı̂n fig. 1.5 şi 1.6.
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Fig. 1.5: Diferenţele dintre elipsoid, geoid şi suprafaţa terestră: (1) ocean;
(2) suprafaţa elipsoidului; (3) firul cu plumb local, care arată sensul
gravitaţiei ı̂n punctul respectiv; (4) continent; (5) suprafaţa geoidului. Sursa:
http://en.wikipedia.org/wiki/Geoid.

Fig. 1.6: Diferenţele dintre 2 modele ale suprafeţei terestre: geoidul
EGM96 şi elipsoidul WGS84. Cu roşu: zonele ı̂n care geoidul este dea-
supra elipsoidului; cu albastru: zonele ı̂n care este dedesubt. Sursa:
http://en.wikipedia.org/wiki/Geoid
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Proiecţia

Indiferent prin ce model este reprezentat, Pământul are o formă circulară. De-
oarece hărţile sunt reprezentări ı̂n plan este nevoie ca suprafaţa Pământului să
fie desfăşurată. Dacă se face aceasta direct vor rezulta deformări, ca ı̂n cazul ı̂n
care s-ar dori ı̂ntinderea unei coji de portocală pe o coală de hârtie. De aceea s-a
recurs la proiectarea suprafeţei aproximativ sferice a Pământului pe o suprafaţă
desfăşurabilă, precum cilindrul, conul sau planul (fig. 1.7). Prin analogie, dacă
s-ar introduce globul terestru ı̂ntr-un cilindru, proiecţia sa ar fi umbra pe acel
cilindru determinată de lumina ce vine de la un bec din centrul globului (acesta
este unul din tipurile de proiecţie).

Fig. 1.7: Tipuri de proiecţie: (a) plană; (b) conică; (c) cilindrică. Sursa:
http://hosting.soonet.ca/eliris/gpsgis/Lec2Geodesy.html
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Datum-ul

Un datum este un set de constante care specifică sistemul de coordonate folosit
pentru determinarea coordonatelor punctelor de pe suprafaţa terestră. Când se
foloseşte pentru calcularea coordonatelor orizontale, setul de constante descrie
datele geodezice fundamentale de referinţă [STAS7488, 1989]:

• coordonatele punctului fundamental al reţelei de triangulaţie4;

• elipsoidul: lungimea semiaxei mari şi turtirea (raportul dintre diferenţa
dintre cele două semiaxe şi axa mare a elipsoidului).

Când se foloseşte pentru măsurarea altitudinilor, datum-ul se referă la un plan
orizontal de referinţă. Problema este destul de complexă şi aici pentru că un
nivel de referinţă aplicabil pentru ı̂ntreaga suprafaţă terestră este greu de definit.
S-a considerat nivelul mării, ı̂nsă acesta variază ı̂n funcţie de condiţiile climatice
locale, de maree, ba chiar şi cu latitudinea, datorită expansiunii termice a apei.
De aceea mulţi ani statele considerau nivelul de bază pentru altitudini nivelul
mării celei mai apropiate. De exemplu, Marea Britanie consideră nivelul de
referinţă media nivelului mării dintre 1915 şi 1921 măsurat la Newlyn, ı̂n Pen.
Cornwall. Mai recent, mai exact odată cu extinderea sistemelor de navigaţie
prin satelit, această problemă s-a rezolvat prin raportarea la suprafaţa geoidului
EGM96 (Earth Gravitational Model folosit ı̂n sistemul de refereinţă WGS845,
elaborat de Departamentul pentru Apărare al SUA.

Sistemul de coordonate

Odată stabilite proiecţia şi datum-ul (care conţine şi descrierea elipsoidului),
poziţia unui punct pe suprafaţa terestră se descrie prin raportare la un sistem
de coordonate. Acesta poate fi:

• cartezian:

– raportarea se face ı̂n unităţi de lungime (m., ft., etc) faţă de două
axe perpendiculare;

– coordonatele se notează cu:

∗ X cele care se determină pe axa OX, paralelă cu ecuatorul;
∗ Y care se determină pe axa OY, paralelă cu axa de rotaţie a

Pământului;

• geografic:

– raportarea se face ı̂n unităţi de măsură de unghiuri, faţă de centrul
Pământului (de fapt, al elipsoidului folosit ca model);

4Pentru determinarea coordonatelor unor puncte oarecare, orice sistem de coordonate are
o reţea de puncte de coordonate cunoscute (denumite puncte geodezice), care sunt folosite
ca repere locale. Punctele ı̂n care s-au realizat şi măsurători de unghiuri faţă de alte puncte
geodezice formează o reţea de triangulaţie (de triunghiuri). Punctul fundamental al reţelei
de triangulaţie este primul reper, punctul din care s-au pornit măsurătorile. Reţelele de
puncte geodezice (de triangulaţie, de sprijin, gravimetrice, etc) sunt adiminstrate de o auto-
ritate naţională, ı̂n cazul ţării noastre de Agenţia Naţională pentru Cadastru şi Publicitate
Teritorială

5Atenţie! denumirea WGS84 se aplică atât unui datum cât şi unui elipsoid, vezi secţiunea
1.2.2
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– coordonatele se notează cu:

∗ latitudine: valoara unghiului dintre verticala punctului dat şi
planul ecuatorului;

∗ longitudine: valoarea unghiului dintre planul meridianului punc-
tului dat şi planul meridianului Greenwich.

Sistemul coordonate se reprezintă pe hărţi printr-un caroiaj, de regulă rectangu-
lar, care marchează coordonate la intervale standard: 1000 km, 1◦, etc. Liniile
acestui caroiaj sunt un bun reper pentru operaţia de georeferenţiere, aşa cum
se va vedea mai departe.

1.2.2 Sisteme de coordonate care se aplică ı̂n România

Sistemul de coordonate geografice

Este folosit pentru reprezentări generale, de regulă didactice, de genul atlaselor
şcolare şi mai nou de aplicaţii precum Google R© Earth6 sau Microsoft R© Virtual
Earth7. Elementele de pe hărţi se descriu prin latitudine şi longitudine pe datum
WGS84.

Sistemul Gauss-Kruger/Pulkovo 1942

Este un sistem preluat de la URSS şi introdus ı̂n România ı̂n 1951. Proiecţia se
numeşte Gauss-Kruger şi este ortografică, cilindrică şi transversală, adică razele
de proiecţie sunt paralele iar cilindrul este dispus orizontal, perpendicular pe axa
de rotaţie a Pământului. Pentru a se evita distorsiunile, s-a ı̂mpărţit suprafaţa
terestră ı̂n 60 de fuse geografice, din 6 ı̂n 6◦ de longitudine (fig. 1.8). Astfel,
există 60 de cilindri de proiecţie, fiecare tangent la meridianul central al fusului
şi deci, practic, 60 de sisteme de coordonate diferite. Pe teritoriul ţării noastre
se suprapun două fuse, sau zone:

• zona 4, ı̂ntre meridianele de 18 şi 24◦ long E;

• zona 5, ı̂ntre meridianele de 24 şi 30◦ long E.

Pulkovo 1940 este denumirea datum-ului, care are ca punct fundamental Obser-
vatorul Astronomic Central al Academiei Ruse de Ştiinţe de la Pulkovo, lângă
Sankt Petersburg, iar ca elipsoid Krassowsky, definit prin semiaxa mare de 6
378 245 m şi turtirea de 1/298.3 (vezi secţiunea 1.2.1) Pe hărţile realizate ı̂n
aceast sistem de proiecţie cotele se raportează la Marea Baltică. Sistemul s-a
folosit până ı̂n 1973 la ı̂ntocmirea, printre altele, a planului topografic de bază,
la scara 1:1000 şi a hărţilor topografice la scara 1:25000 [Moroşanu, 2007].

Sistemul Stereo 70/Dealul Piscului 1970

Acest sistem a fost utilizat ı̂ncepând cu anul 1973 şi este şi ı̂n prezent, oficial,
sistemul naţional de referinţă. Se bazează pe proiecţia Stereo 70, care este o
proiecţie stereografică, diferită de cea anterioară: suprafaţa de proiecţie este un
plan care intersectează suprafaţa terestră curbată ı̂n regiunea tării noastre. Din
intersecţie rezultă un cerc cu centrul aproximativ ı̂n centrul ţării, la intersecţia

6maps.google.com
7http://maps.live.com/
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Fig. 1.8: Sistemul de proiecţie Gauss-Kruger. Sursa:
http://earth.unibuc.ro/articole/deformatii-liniare-in-sistemele-proiectie

paralelei de 46◦ lat. N cu meridianul de 25◦ long. E. Aceasta este punctul
central al proiecţiei iar punctul de origine a razelor de proiecţie este situat pe
cerc, diametral opus (fig. 1.9).

În privinţa datum-ului, Dealul Piscului 1970, există câteva incertitudini ı̂n
privinţa denumirii. Acestea provin, probabil, din faptul că implementarea da-
tum-ului Pulkovo 1942 ı̂n ţările satelit ale URSS s-a realizat sub denumirea
de S-42 (Sistem 42). În România s-a renunţat la acest sistem şi s-a adoptat
proiecţia Stereo 70 cu un datum bazat tot pe elipsoidul Krassovsky, dar cu
punctul fundamental ı̂n Observatorul Astronomic Militar din Dealul Piscului,
din Bucureşti (de unde şi denumirea) [Mugnier, 2001]. Problema este că acest
nou datum apare până azi şi cu denumirea de S-42, după cum se observă pe
site-ul ANCPI8. Incertitudinile apar ı̂n anumite aplicaţii GIS ı̂n care se recu-
nosc atât datum-ul Pulkovo 1942 cât şi S-42 şi Dealul Piscului. De exemplu ı̂n
aplicaţia Global Mapper9, situaţia diferă de la o versiune la alta:

• ı̂n versiunea 8, nu există denumirea Dealul Piscului 1970, ı̂n schimb datum-
ul apare cu denumirea S-42(ROMANIA) şi este definit cu un set de 7
parametri de transformare către WGS84;

• ı̂n versiunea 9 apare o definiţie pentru un datum cu denumirea Dealul
Piscului 1970, dar cu doar 3 parametri de transformare (ducând la trans-
formări cu o acurateţe mai mică), şi se menţin datum-urile S-42(ROMANIA)
şi PULKOVO 1942;

• ı̂n ultima versiune s-au păstrat datum-urile S-42(ROMANIA), DEALUL
PISCULUI 1970, iar PULKOVO 1942 a devenit S-42(PULKOVO 1942).

8http://www.ancpi.ro/pages/wiki.php?lang=ro&pnu=transformariCoordonate
9detaliem pentru această aplicaţie deoarece aceasta se va folosi pentru georeferenţiere mai

departe
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Fig. 1.9: Sistemul de proiecţie Stereo 70. Sursa:
http://earth.unibuc.ro/articole/deformatii-liniare-in-sistemele-proiectie

În concluzie, din practică, s-a observat că introducerea datum/ului Dealul Piscu-
lui 1970 ı̂n versiunile mai noi şi definirea unei transfomări către WGS84 cu doar
3 parametri a dus la transformări de coordonate mai puţin precise. De aceea
recomandăm ca, ı̂n aplicaţia Global Mapper, indiferent de ediţie să se asocieze
proiecţia Stereo 70 cu datum-ul S-42(ROMANIA) şi proiecţia Gauss-Kruger cu
datum-ul PULKOVO 1942 sau S-42(PULKOVO 1942).
În aplicaţia dezvoltată de ESRI, ArcGIS R©, problema aceasta nu apare, deoa-
rece programul selectează automat datum-ul ı̂n funcţie de proiecţia aleasă. În
alte programe de GIS trebuie să se acorde mare atenţie acestor detalii şi să se
studieze documentaţia de help, deoarece o interpretare greşită a sistemului de
proiecţie poate genera erori de reprezentare.
Acest sistem a fost folosit la elaborarea planurilor topografice de bază, la scările
1:2000, 1:5000, 1:10000 precum şi a hărţilor cadastrale la scara 1:50000 [Moroşanu,
2007]. De asemenea, este folosit pentru reprezentarea ortofotoplanurilor la di-
ferite scări, disponibile ı̂n Fondul Naţional Geodezic10. Pe hărţile realizate ı̂n
această sistem, cotele sunt raportate la nivelul Mării Neagre.

10http://www.ancpi.ro/pages/wiki.php?lang=ro&pnu=hartiSiPlanuri
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Sistemul UTM/WGS84

A fost introdus ı̂n România după 1989 şi ı̂n prezent capătă o foarte mare
importanţă datorită integrării României ı̂n NATO şi Uniunea Europeană, de-
oarece ı̂n prezent, acest sistem este unul de referinţă la nivel mondial şi este
folosit, printre altele, pentru schimbul de date ı̂ntre instituţii din state diferite.
Proiecţia nu diferă fundamental de Gauss-Kruger, este tot cilindrică, ortografică
şi transversală. De altfel denumirea UTM este acronimul Universal Transverse
Mercator (Proiecţie Universală Transversală Mercator) care este o proiecţie de-
rivată din Proiecţia Mercator, dezvoltată de cartograful flamand Gerardus Mer-
cator ı̂n 1569. Se menţine ı̂mpărţirea globului ı̂n fuse de câte 6 grade, diferenţa
constând ı̂n faptul că cilindrul de proiecţie intersectează suprafaţa terestră la
latitudinile de 80◦ S şi 84◦ N şi meridianele marginale care delimietază fusurile
(1.10).

Fig. 1.10: Sistemul de proiecţie UTM. Sursa:
http://earth.unibuc.ro/articole/deformatii-liniare-in-sistemele-proiectie

Datum-ul WGS84 se bazează pe elipsoidul WGS84, definit prin semiaxa mare
de 6 378 137 m şi turtirea de 1/298.257223563 (vezi secţiunea 1.2.1). De aseme-
nea, pentru precizarea cotelor, se foloseşte geoidul EGM9611. În ţara noastră
acest sistem de proiecţie s-a folosit pentru elaborarea hărţii topografice la scara
1:100000, ediţia 1996.

11http://en.wikipedia.org/wiki/WGS84
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Capitolul 2

Georeferenţierea planşelor
scanate

Georeferenţierea unei imagini presupune alinierea acesteia la un sistem de co-
ordonate definit. În felul acesta imaginea un set de date spaţiale, iar prima
consecinţă a acestui fapt este că scara reprezentării devine variabilă. Se poate
”naviga” deasupra imaginii la ”̂ınălţmi” diferite, controlate prin factorul de
zoom.
Matematic, este o operaţie de translaţie şi/sau rotaţie a sistemului de coor-
donate al imaginii (care numerotează coloanele şi liniile de pixeli ı̂ncepând
cu cel din stânga sus) faţă de sistemul de coordonate ı̂n care se realizează
georeferenţierea. Problema se rezumă la rezolvarea unor sisteme de ecuaţii şi
aflarea unor coeficienţi care se aplică fiecărui pixel al imaginii pentru a-l face să
corespundă unei anumite poziţii geografice, definite printr-o pereche de coordo-
nate matematice sau geografice. Concret, utilizatorul oferă ca input puncte de
pe imagine ale căror coordonate le cunoaşte, iar programul aplică un algoritm
ı̂n funcţie de numărul de puncte introduse (care oricum trebuie să fie cel puţin
trei).
Selectarea punctelor de control se poate face ı̂n două feluri:

1. fie utilizatorul le alege direct de pe hartă, ı̂n cazul ı̂n care are la dispoziţie
puncte de coordonate cunoscute (de regulă la intersecţiile liniilor caroia-
jului)

2. fie se foloseşte de imagini sau hărţi deja georeferenţiate şi identifică ele-
mente comune pe harta negeoreferenţiată.

Imaginea este astfel rectificată şi poate fi salvată separat, ı̂mpreună cu informaţiile
de georeferenţiere (care se salvează fie ı̂ntr-un fişier separat, cu acelaşi nume dar
cu extensie diferită, de ex. .jgw, .tfw, .eww, fie ı̂n headerul imaginii, ı̂n cazul
fişierelor geotiff).
Vom detalia această operaţie, ı̂n ambele moduri enunţate mai sus, ı̂n aplicaţia
Global Mapper, versiunea 10, dezvoltată de o companie din SUA.1

1Global Mapper LLC, www.globalmapper.com
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Pentru ı̂nceput vom prelua o imagine dintr-o sursă publică. S-a ales un fragment
de hartă topografică scanată, la scara 1:25000, cu zona Câmpulung Moldove-
nesc, de pe site-ul geo-spaţial.org2 (fig. 2.1). Harta este ı̂n proiecţia Stereo
70, după cum rezultă din legendă şi din valorile coordonatelor de pe marginea
caroiajului.

Fig. 2.1: Harta scanată folosită ca exemplu pentru operaţia de georeferenţiere

2http://earth.unibuc.ro/galerii/?c=gal topografice&p=684
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2.1 Georeferenţierea pe baza punctelor de pe
hartă

Hărţile topografice, precum cea folosită pentru exemplificare, prezintă avantajul
că oferă utilizatorului toate informaţiile de care are nevoie: tipul de proiecţie şi
puncte de coordonate cunoscute. În cazul nostru, harta este ı̂n proiecţia Stereo
70, iar pentru selectarea punctelor de coordonate cunoscute (numite şi puncte
de control) vom folosi intersecţiile liniilor caroiajului.

Se porneşte aplicaţia Global Mapper şi se ı̂ncarcă imaginea care va fi georeferenţiată:
click pe Open Your Own Data Files apoi se selectează imaginea, ı̂n cazul nostru
topo.jpg, şi apoi click pe Open (fig. 2.2)

Fig. 2.2: Fereastra de start a aplicaţiei Global Mapper şi selecţia fişierului de
georeferenţiat

Mesajul care apare imediat după ı̂ncărcare (fig. 2.3) arată că aplicaţia nu a putut
determina proiecţia şi sistemul de coordonate al imaginii. Opţiunea ı̂n cazul,
acesta este selectarea butonului Yes pentru a georeferenţia manual imaginea
(Manually rectify the image).

Urmează un mesaj ı̂n care se explică succint procedura de georerenţiere: click
pe OK.
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Fig. 2.3: Mesajul care anunţă că imaginea nu este georeferenţiată

Imaginea s-a ı̂ncărcat ı̂n fereastra Image Rectifier care este ı̂mpărţită ı̂n 2 (fig.
2.4):

• ı̂n partea de sus, şi care ocupă cea mai mare parte a ferestrei, sunt 3
zone care permit vizualizarea, navigarea şi selectarea punctelor de control.
Aceasta se face ı̂n zona din mijloc, cu mouse-ul astfel:

– cu butonul din dreapta se face zoom out ;

– cu butonul din stânga se selectează punctele de control, cu click sim-
plu şi se face zoom in cu click & drag ;

• ı̂n partea de jos este o zonă ı̂n care se introduc coordonatele punctelor de
control şi ı̂n care se selectează proiecţia.

Fig. 2.4: Fereastra de georeferenţiere din aplicaţia Global Mapper

Se observă că aplicaţia a selectat automat proiecţia geografică pe datum WGS84.
Georeferenţierea trebuie să se realizeze ı̂n sistemul de coordonate ı̂n care este
harta scanată. De aceea, ı̂n cazul nostru, trebuie selectat sistemul de proiecţie
corespunzător. Se face click pe Select Projection, apoi ı̂n fereastra care apare
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se selectează proiecţia Stereo70 din câmpul Projection şi datum-ul S-42 RO-
MANIA din câmpul cu acelaşi nume. Unitatea de măsură se modifică automat
ı̂n metri: Planar Units: METERS (fig. 2.5). Click pe OK

Fig. 2.5: Selecţia sistemului de coordonate

Mai departe se vor selecta puncte de coordonate cunoscute de pe imagine.
Se localizează o intersecţie de linii de caroiaj, cum este cea din stânga jos a hărţii,
ı̂ntre linia de abscisă 540000 şi cea de ordonată 667500. Se face zoom in ı̂n fe-
reastra din mijloc cu click & drag până la nivel de pixel, la intersecţia respectivă
şi se face click cât mai aproape de centrul intersecţiei (fig. 2.6). În momentul
acesta punctul a fost marcat prin coordonatele interne ale imaginii (̂ın câmpurile
PixelX şi PixelY ) iar aplicaţia aşteaptă de la utilizator să introducă valorile
coordonatelor din sistemul de proiecţie ales (̂ın câmpurile X/Easting/Lon, res-
pectiv Y/Northing/Lat). Aceasta se va face manual, de la tastatură, iar valorile
se preiau de pe hartă: 540000, valoarea de pe axa X, ı̂n câmpul X/Easting/Lon
şi 667500, valoarea de pe axa Y, ı̂n câmpul Y/Northing/Lat. Apoi se face click
pe Add GCP to List şi OK ı̂n fereastra care apare pentru selectarea numelui
Point 1, iar punctul va apărea ı̂n tabelul Ground Control Points, din partea de
jos a ferestrei.
Se continuă ı̂n mod analog până se introduc cel puţin 4 puncte3. Se va avea
ı̂n vedere că rezultatele cele mai bune se obţin dacă punctele sunt distribuite
uniform pe suprafaţa hărţii, nicidecum pe o linie sau aglomerate ı̂ntr-o regiune
a hărţii (fig. 2.7).

3numărul minim suficient pentru a se aplica un algoritm de georeferenţiere este de 2 puncte,
dar cel mai bine este să se introducă minim 4 puncte
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Fig. 2.6: Selecţia unui punct de coordonate cunoscute

Fig. 2.7: Selecţia unui număr suficient de puncte de coordonate cunoscute

După cum s-a afirmat la ı̂nceput, georeferenţierea este o operaţie de transfor-
mare (translaţie şi/sau rotaţie) a sistemului de coordonate intern al imaginii
ı̂n noul sistem de coordonate. Aplicaţia oferă posibilitatea selectării tipului de
tranformare, care depinde de numărul de puncte oferite ca input.
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Astfel (fig. 2.8):

• pentru o tranformare liniară este nevoie de minim 2 puncte de control;

• pentru o tranformare afină este nevoie de minim 3 puncte de control;

• pentru o tranformare polinomială este nevoie de minim 4 puncte de con-
trol;

• pentru o tranformare prin triangulaţie este nevoie de minim 5 puncte de
control.

Dacă se selectează Automatic, ca ı̂n cazul nostru, programul va aplica algoritmul
ı̂n funcţie de numărul de puncte de control, care determină de asemenea şi gradul
de complexitate şi acurateţea transformării. Din practică, s-a observat că dacă
punctele se pot identifica uşor pe hartă, ca ı̂n cazul nostru, când a existat
un caroiaj, atunci este suficientă o transformare cu 4 puncte, iar dacă sunt şi
uniform distribuite, chiar 3 puncte. În tot cazul, pentru acurateţe şi pentru
exemplificare, am preferat introducerea a 4 puncte de control.

Fig. 2.8: Selecţia tipului de transformare
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În acest moment imaginea este georeferenţiată. Se face click pe OK şi aceasta
se ı̂ncarcă ı̂n fereastra principală a programului, care a stocat intern toate
informaţiile privind georeferenţierea. Este nevoie ca acestea să se salveze pe disc,
ı̂ntr-un fişier separat, pentru ca imaginea să poată fi recunoscută ca georeferenţiată
şi de către alte aplicaţii de GIS. Pentru aceasta, se va exporta imaginea ı̂n acelaşi
format, .jpg, cu o altă denumire. Se face click pe File, apoi Raster and Ele-
vation Data, apoi Export JPG (fig. 2.9). În fereastra care apare se prezintă
opţiunile pentru de salvare a imaginii. Se bifează: Always Generate Square Pi-
xels şi Generate World File. Acest fişier World va avea aceeaşi denumire cu cea
a imaginii, dar extensia .jgw. Este foarte important să se păstreze acest fişier ı̂n
acelaşi folder ı̂n care se păstrează imaginea, deoarece aici se salvează detaliile
georeferenţierii. În orice aplicaţie de GIS se va introduce de acum imaginea,
aceea va căuta aceast fişier pentru a o localiza corect pe suprafaţa terestră. Se
debifează Generate Projection (PRJ) File, iar restul opţiunilor se lasă nemo-
dificate. Se face click pe OK, apoi se alege unde se va salva şi se denumeşte
imaginea (de exemplu topo georef.jpg).

Fig. 2.9: Exportul imaginii georeferenţiate ı̂n format .jpg

Se ı̂nchide Global Mapper şi se pot verifica pe disc fişierele nou create: topo georef.jpg
(imaginea ı̂n sine) şi topo georef.jgw (datele de georeferenţiere), iar imaginea
iniţială, topo.jpg, a rămas nemodificată.
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2.2 Verificarea acurateţii georeferenţierii

În continuare, vom prezenta o modalitate prin care se poate verifica dacă o
imagine a fost bine georeferenţiată, folosind o aplicaţie care a câştigat foarte
multă popularitate ı̂n ultimul timp: Google Earth. În versiunea 4.3 această
aplicaţie oferă un model al suprafeţei terestre pe care se poate naviga şi vizualiza
o serie de date spaţiale4, precum:

• ı̂n primul rând imagini satelitare care acoperă toată suprafaţa Pământului,
la rezoluţii variind de la mai puţin de 1 m pentru zonele rezidenţiale ale
statelor dezvoltate, la 30 m ı̂n zonele mai puţin populate (deşerturi, junglă,
munţi ı̂nalţi, etc);

• o perspectivă tridimensională a suprafeţei terestre, pe baza unui model
numeric altitudinal;

• limite de unităţi administrative şi localităţi;

• o bază impresionantă de informaţii localizate exact, provenind de la di-
ferite agenţii guvernamentale sau neguvernamentale din ı̂ntreaga lume,
precum şi de la utilizatori individuali: fotografii, articole, modele 3D de
clădiri, etc.)

Google Earth permite deasemenea vizualizarea propriilor date spaţiale pe acel
model al suprafeţei terestre. Această funcţie este cea care permite verifica-
rea acurateţii georeferenţierii: dacă imaginea a fost georeferenţiată corect, la
ı̂ncărcarea ı̂n Google Earth ea se va suprapune exact pe suprafaţa terestră vir-
tuală a aplicaţiei şi se va compara cu imaginea satelitară din zonă respectivă.

Pentru aceasta este nevoie ca imaginea ı̂n format .jpg să fie transformată ı̂n
format .kmz care este formatul suportat de Google Earth, prin intermediul
Global Mapper. Se deschide programul Global Mapper şi se ı̂ncarcă imagi-
nea georeferenţiată ı̂n secţiunea anterioară (topo georef.jpg). De data aceasta
nu mai apare mesajul prin care se anunţa că imagine nu este georefereţiată
(fig. 2.3), semn că aplicaţia a identificat fişierul cu datele de georeferenţiere
(topo georef.jgw). În fereastra care apare ni se solicită ı̂nsă precizarea proiecţiei
şi datum-ului 5. Se alege proiecţia Stereo 70 şi datum-ul S-42(ROMANIA) şi se
face click pe OK (fig. 2.10).
Imaginea a fost ı̂ncărcată ı̂n aplicaţie, iar faptul că este georeferenţiată se con-
firmă prin aceea că pentru orice poziţie a mouse-ului pe ecran se precizează
coordonatele ı̂n colţul din dreapta jos al ferestrei.
Mai departe, de aici se va exporta imaginea ı̂n format .kmz pentru Google Earth.
Aceasta se face ca ı̂n mod analog cu exportul ı̂n format .jpg din secţiunea
anterioară, numai că acum se va selecta File>Export Raster and Elevation
Data>Export KML/KMZ... ı̂n loc de Export JPG...6.

4Atenţie! Aceste date sunt supuse unor Termene şi condiţii care limitează folosirea lor ı̂n
afara aplicaţiei Google Earth. Referinţa: http://pack.google.com/intl/en/eula print.html

5 Aceste sunt informaţiile care s-ar fi salvat ı̂n fişierul .prj (Projection File) dacă s-ar fi
bifat opţiunea aceasta ı̂n momentul exportului din Global Mapper a imaginii georeferenţiate
(fig. 2.9). Motivul pentru care nu s-a salvat acel fişier atunci este faptul că unele aplicaţii nu
ı̂l interpretează corect şi aceasta poate duce la erori de reprezentare. De aceea este nevoie să
se precizeze mereu tipul de proiecţie al imaginii, când se ı̂ncarcă ı̂ntr-o aplicaţie GIS

6 De fapt, acum aplicaţia realizează şi o transformare de coordonate a imaginii din sistemul
Stereo 70 ı̂n sistemul Geografic/WGS84. Această operaţie va fi detaliată ı̂n capitoul următor...
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Fig. 2.10: Selectarea sistemului de proiecţie

În fereastra care apare se vor selecta opţiunile de export (similiar cu cele din
fig. 2.11)

• formatul de imagine JPG;

• rezoluţia nu se va modifica (câmpurile X-axis şi Y-axis);

• se va debifa ultima opţiune: Automatically Grid Export of Large Data Sets
so that....

Fig. 2.11: Exportul ı̂n format .kmz pentru Google Eath

Se alege locul unde se va salva şi denumirea noului fişier (de exemplu topo georef.kmz).
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Pentru a se vizualiza orice set de date .kmz ı̂n aplicaţia Google Earth se face
dublu-click pe fişierul respectiv. Efectul este specaculos, deoarece programul
simulează un zbor ı̂n coborâre de la o altitudine mare şi de deasupra Americii
de Nord până la setul de date ı̂ncărcat, ı̂n cazul nostru, ı̂n nordul Carpaţilor
Orientali, pe Valea Moldovei, ı̂n Câmpulung Moldovenesc. Dacă se doreşte
ı̂ncărcarea altor seturi de date după ce s-a pornit aplicaţia, aceasta se face din
File>Open sau cu combinaţia de taste Ctrl+O. În Google Earth, toate datele
ce se ı̂ncarcă sunt organizate ı̂n strate şi afişate ı̂ntr-un tabel ı̂n stânga ferestrei
principale, de unde se pot bifa, pentru vizualizare, sau debifa pentru ascundere
sau se pot selecta pentru a li se modifica modul de afişare (transparenţa, culoa-
rea, etc.). Modificarea modului de afişare a vizualizate ı̂n Google Earth se face
cu click -dreapta pe setul respectiv, apoi Properties. În cazul nostru este de dorit
modificarea transparenţei pentru a se analiza acurateţea georeferenţierii. Harta
ar trebui să se suprapună exact pe imaginea satelitară din aplicaţie. Aceasta se
face prin glisarea butonului din câmpul Transparency (fig. 2.12).

Fig. 2.12: Vizualizarea datelor ı̂n Google Earth: Cercurile roşii pun ı̂n evidenţă:
ı̂n stânga tabelul de unde se pot modifica proprietăţile seturilor de date
ı̂ncărcate; ı̂n centru butonul de unde se poate seta gradul de transparenţă al
unui set de date, ı̂n cazul nostru imaginea georeferenţiată ı̂n secţiunea trecută;
ı̂n dreapta: denumirea Câmpulung Moldovenesc din aplicaţia Google Earth.

Verificarea se face acum vizual, prin navigare pe hartă.
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2.3 Georeferenţierea pe baza punctelor comune
cu planşe georeferenţiate anterior (exemplul
1)

În unele cazuri, pe imaginea scanată nu se află puncte ale căror coordonate
se cunosc ca, de exemplu, ı̂n cazul fotografiilor aeriene sau ale planşelor din
planurile urbanistice generale ale localităţilor. Pentru acestea, se impune o
abordare diferită pentru georeferenţiere. Mai ı̂ntâi trebuie precizat faptul că,
mai ales ı̂n cazul imaginilor aeriene, aceastea pot conţine erori de reprezentare
din cauze precum:

• fotografiile au fost realizate cu camera ı̂nclinată faţă de suprafaţa terestră7;

• chiar dacă au fost realizate perpendicular, deşi e foarte puţin probabil din
cauza instabilităţii zborului avionului, s-a fotografiat suprafaţa curbată a
Pământului; efectul este mai vizibil pe măsură ce creşte altitudinea, iar
un bun exemplu este chiar modelul suprafeţei terestre din Google Earth;

• planurile au fost realizate defectuos, fără să se respecte pe hartă unghiurile
sau distanţele (reduse la scară) dintre obiecte, din realitate.

În aceste condiţii, imaginea georeferenţiată poate prezenta distorsiuni faţă de
cea iniţială, iar operaţia ı̂n sine se realizeză acum cu o acurateţe mai mică.
Aceste imagini se pot georeferenţia prin comparare cu seturi de date (raster sau
vector) deja georeferenţiate pe zona respectivă.

Pentru detalierea acestei metode se va folosi o aerofotogramă negeoreferenţiată
(Enisala 1969.jpg, fig. 2.13), furnizată de INMI şi un set de date vector, georeferenţiate,
preluate din aplicaţia Google Earth8. Setul de date georeferenţiate va constitui
sursa pentru punctele de control, iar georeferenţierea se va realiza ı̂n aceeaşi
aplicaţie: Global Mapper 10. Această modalitate presupune că utilizatorul ştie
ce zonă este reprezentată pe aerofotogramă, deoarece trebuie să o localizeze pe
Google Earth. Acolo va marca puncte care se vor salva ı̂n acelaşi format .kmz,
de data aceasta ca date vector, pe care le va folosi ca puncte de reper pentru
georeferenţiere.

7 Ortofotoplanurile sunt un fotografii aeriene corectate de aceste distorsiuni de perspectivă
ce rezultă ca urmare a ı̂nclinării camerei ı̂n momentul fotografierii

8 Atenţie! Google nu garantează acurateţea reprezentărilor din aplicaţie. Acestea pot
conţine erori de localizare de până la câţiva zeci de metri. Însă pentru exemplificarea ı̂n
această metodologie considerăm că asigură un grad suficient de acurateţe. Este de dorit ca,
ı̂n aplicaţii profesionale, să se folosească surse de date spaţiale georeferenţiate cu o acurateţe
ridicată (de exemplu ortofotoplanuri furnizate de ANCPI)
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Fig. 2.13: Aerofotograma care se va georeferenţia

Pentru ı̂nceput se va porni aplicaţia Google Earth şi se va localiza regiunea
reprezentată pe aerofotogramă. Aceasta corespunde aproximativ celei din fig.
2.14.

Fig. 2.14: Zona din Google Earth corespunzătoarea aerofotogramei
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Se observă că ı̂ntre cele două imagini există diferenţe. Cea disponibilă pe Go-
ogle Earth este mai recentă şi conţine elemente ı̂n plus faţă de aerofotogramă.
În tot cazul sunt ı̂ncă suficiente elemente comune care pot fi folosite ca puncte
de reper. În cazul nostru vom alege ı̂n principal puncte la intersecţii de drumuri.

Se face zoom in către un astfel de punct care se va marca cu butonul Add
Placemark din bara de unelte a aplicaţiei (fig. 2.15). Activarea acestui buton
are ca efect marcarea unui punct ı̂n centrul cadrului. De acolo se mută cu
mouse-ul ı̂n locul dorit şi se redenumeşte ı̂n câmpul Name din ferastra New
Placemark (fig. 2.16).

Fig. 2.15: Butonul Add Placemark cu care se vor lua punctele de control ı̂n
Google Earth

Fig. 2.16: Plasarea şi denumirea unui punct ı̂n Google Earth
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În mod analog se procedează şi cu restul punctelor, până când se obţine un
număr suficient, distribuite cât mai uniform (fig. 2.17).

Fig. 2.17: Poziţia punctelor de control pe imaginea din Google Earth

Aceste puncte se vor exporta ı̂ntr-un fişier .kmz care va fi folosit apoi ı̂n Glo-
bal Mapper ca reper pentru georeferenţierea aerofotogramei. Înainte de expor-
tul propriu-zis se vor aranja punctele ı̂ntr-un folder ı̂n aplicaţia Google Earth.
Acesta se creează cu click -dreapta pe My Places, apoi Add>Folder (fig. 2.18),
iar ı̂n fereastra care apare se va menţiona denumirea, ı̂n câmpul Name şi,
opţional, o descriere a setului de date, ı̂n câmpul Descrition (fig. 2.19). După
crearea folder -ului, se introduc punctele de control: se face click pe denumirea
punctului şi se trage ı̂n dreptul denumirii folderului. Apoi se exportă tot fol-
der -ul cu click -dreapta pe denumirea sa şi Save Places As (fig. 2.20). Se aleg
locul şi denumirea fişierului .kmz exportat (de exemplu puncte control.kmz).

Fig. 2.18: Crearea unui folder pentru organizarea datelor
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Fig. 2.19: Denumirea unui folder şi adăugarea unei descrieri

Fig. 2.20: Exportul punctelor de control
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Acest fişier se ı̂ncarcă apoi ı̂n aplicaţia Global Mapper ı̂n modul arătat ı̂n
secţiunile anterioare (fig. 2.21).

Fig. 2.21: Importul punctelor de control ı̂n Global Mapper. Dacă fişierul nu
este vizibil pentru selctare, se verifică tipul de fişier: ı̂n câmpul Files of type: se
alege Common Suported Vector Types

Acum se poate ı̂ncepe georeferenţierea. Se face click pe File>Rectify (Georefe-
rence) Imagery... din meniul aplicaţiei (fig. 2.22), iar ı̂n fereastra care apare se
selectează opţiunile ca ı̂n fig. 2.23. Apoi se alege imaginea (Enisala 1969.jpg),
care se va ı̂ncărca ı̂ntr-o fereastră similară cea din fig. 2.4 şi 2.24.

Fig. 2.22: Accesarea uneltei de georeferenţiere din meniul aplicaţiei Global Ma-
pper
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Fig. 2.23: Opţiunile premergătoare georeferenţierii. Se observă că, spre deose-
bire de data trecută, acum imaginea georeferenţiată se va exporta direct

Fig. 2.24: Aceeaşi fereastră de georeferenţiere ca cea din fig. 2.4, cu deosebirea
că acum sunt reprezentate şi punctele preluate de pe Google Earth, ca repere,
ı̂n zona din dreapta.
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Operaţia de georeferenţiere nu diferă fundamental de ce s-a prezentat anterior.
Deosebirea este că ı̂n loc să se scrie de la tastatură coordonatele punctelor de
control, se vor prelua cu click pe punctul de reper din zona din dreapta. Se va
selecta ı̂n acelaşi mod sistemul de proiecţie (vezi fig. 2.5). Apoi, pentru fiecare
punct de control se va face zoom in până la nivel de pixel, pe aerofotograma
din zona din mijloc şi click pentru a i se determina coordonatele ı̂n sistemul
intern al imaginii. Apoi se va face click pe punctul corespunzător din zona din
dreapta, pentru a i se determina coordonatele ı̂n sistemul de proiecţie. Apoi
după ce se vor insera valorile ı̂n câmpurile Pixel X, Pixel Y, X/Easting/Lon şi
Y/Northing/Lat (ca ı̂n fig. 2.6) se va face click pe Add GCP to List, iar punctul
se va salva ca punct de control ı̂n tabelul din partea de jos (fig. 2.25).

Fig. 2.25: Selecţia unui punct de control. Detalii ı̂n text.

În mod analog se procedează cu restul punctelor. Această metodă prezintă
o acurateţe mai scăzută decât cea anterioară, de aceea este posibil să apară
erori de localizare a punctelor de control pe aerofotogramă. Aplicaţia oferă un
control al acestora: pe coloana Error apar valorile acestor erori, exprimate ı̂n
unităţile de măsură ale sistemului de coordonate (̂ın cazul nostru, Stereo 70,
metri). Ţinând cont de precizarea de mai sus, se consideră acceptabile valori de
câţiva metri. În cazul ı̂n cazul ı̂n care acestei erori sunt prea mari (valoarea de
prag o stabileşte utilizatorul, ı̂n funcţie de acurateţea cu care vrea să realizeze
georeferenţierea), fie se mai şterge din punctele de control, fie se reface fişierul
cu puncte de reper din Google Earth mai clar localizate. În cazul nostru, de
exemplu, s-a observat că introducerea punctului 6 determină o eroare de 8.14 m
la punctul 1. Ţinând cont de numărul total de puncte şi de distribuţia uniformă
a acestora s-a renunţat la folosirea punctului 6 ca punct de control (fig. 2.26).
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Fig. 2.26: Pe măsură ce se aleg puncte de control se verifică eroarea de localizare

După ce s-au ales toate punctele de control se face click pe OK, iar aerofo-
tograma astfel georeferenţiată se va salva ı̂ntr-un fişier cu extensia .jpg şi cu
menţiunea rectified adăugată denumirii iniţiale (̂ın cazul nostru Enisala 1969
rectified.jpg). Datele de georeferenţiere se vor salva, ca mai ı̂nainte, ı̂n fişierul

asociat cu extensia .jgw. Rezultatul se poate verifica ı̂n Google Earth ı̂n modul
prezentat ı̂n secţiunea anterioară, iar ı̂n cazul nostru se observă că imaginea a
fost distorsionată faţă de original (fig. 2.27). Acesta este un semn posibil că
imaginea iniţială nu a fost ortorectificată. Aceste distorsiuni se diminuează prin
ı̂ndesirea punctelor de control şi distribuirea lor cât mai uniform. De aceea,
aerotogramele din zone fără repere vizibile (păduri, lacuri, câmpuri, etc) sunt
foarte greu de georeferenţiat ı̂n acest mod: lipsesc punctele ce pot fi luate ca
repere, iar imaginea, nefiind ortorectificată, este ı̂n sine o reprezentare aproxi-
mativă. În cazul nostru, ı̂n jumătatea nordică a aerofotogramei s-a folosit ca
reper doar punctul 3. Acolo se observă că georeferenţierea este inexactă: canalul
de pe aerofotogramă nu se suprapune exact pe cel de pe imaginea din Google
Earth.
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Fig. 2.27: Verificarea imaginii georeferenţiate ı̂n Google Earth

2.4 Georeferenţierea pe baza punctelor comune
cu planşe georeferenţiate anterior (exemplul
2)

Pentru materialul de faţă, pentru a se asigura continuitatea, se va prelua o ima-
gine satelitară de pe Google Earth, din zona Câmpulung Moldovenesc, care se
va georeferenţia pe baza hărţii deja georeferenţiate. Astfel se va detalia, practic,
georeferenţierea unei aerofotograme ortorectificate, de data aceasta ı̂n aplicaţia
ArcMap a suitei ArcGIS, versiunea 9.2, dezvoltată de ESRI 9.

În Google Earth se face zoom in către o zonă din oraşul Câmpulung Moldove-
nesc după ce, dacă e cazul, se debifează din tabel harta georeferenţiată care se
suprapune pe imaginea satelitară. După ce s-a fixat cadrul, se alege din meniu
File>Save >Save Image... (fig. 2.28). În fereastra care apare se indică locul de
pe disc şi denumirea imaginii (de exemplu topoGE.jpg). Aplicaţia va exporta
cadrul fixat ı̂n format .jpg (fig. 2.29)10.

După ce s-a pregătit imaginea aeriană, se porneşte aplicaţia ArcMap şi se ı̂ncarcă
mai ı̂ntâi harta georeferenţiată: topo georef.jpg. Aceasta se face cu click pe
butonul Add Data din bara de unelte a aplicaţiei (fig. 2.30).

9http://www.esri.com/software/arcgis/
10 Atenţie! Folosirea imaginilor satelitare ı̂n afara aplicaţiei Google Earth este supusă unor

termene şi condiţii restrictive
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Fig. 2.28: Exportul unei imagini din Google Earth.

Fig. 2.29: Imaginea preluată de pe Google Earth: topoGE.jpg

Fig. 2.30: Încărcarea unui set de date ı̂n ArcMap
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În fereastra care apare se alege imaginea şi se face click pe Add. În fereastra
următoare se face Yes pentru crearea pyramids11 (fig. 2.31), iar ı̂n continu-
are apare un msesaj care anunţă că setul de date care se ı̂ncarcă nu conţine
informaţii despre sistemul de proiecţie (fig. 2.32) (̂ın mod similar s-a ı̂ntâmplat
şi la ı̂ncarcarea ı̂n aplicaţia Global Mapper). Se face click pe OK şi se observă că
ı̂n colţul din dreapta jos apar coordonatele care corespund poziţiei mouse-ului,
cu precizarea Unknown Units (unităţi de măsură neidentificate). Deci, aplicaţia
poziţionează corect imaginea, ı̂nsă nu ”ştie” ı̂n ce unităţi de măsură pentru că
nu găseşte nici un fişier cu extensia .prj ı̂n care să se specifice acestea. Faptul
nu afectează operaţia de georeferenţiere, deoarece este suficient să se cunoască
sistemul de proiecţie doar de către utilizator.

Fig. 2.31: Selecţia opţiunii Add pyramids

Fig. 2.32: Mesajul de avertizare că aplicaţia nu regăseşte denumirea sistemului
de proiecţie

În mod analog se ı̂ncarcă şi imaginea aeriană (topoGE.jpg). Diferenţa va fi că,
din cauză că imaginea nu este georeferenţiată, aplicaţia o va ı̂ncărca ı̂nsă va
”citi” coordonatele interne ale imaginii (cele care pornesc din colţul din stânga
sus cu valorile X=0 şi Y=0) şi o va poziţiona ca atare, fără legătură cu datele
deja ı̂ncărcate. În ArcMap operaţia de georeferenţiere este accesibilă dintr-
o bară de unelte care se accesează din meniul View>Toolbars>Georeferencing
(fig. 2.33).

11 Aceasta este o opţiune ce permite vizualizarea mai rapidă a datelor raster de mari di-
mensiuni. Nu vom insista asupra acestui aspect aici.
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Fig. 2.33: Accesarea barei de unelte pentru georeferenţiere

Pe această bară de unelte există un câmp denumit Layer. Aici se va selecta
imaginea care va fi georeferenţiată (̂ın cazul nostru topoGE.jpg.) (fig. 2.34).
Acest detaliu este foarte important, deoarece dacă se omite, există riscul este să
se ”strice” imaginile deja georeferenţiate care sunt şi ele ı̂ncărcate ı̂n aplicaţie.

Fig. 2.34: Bara de unelte pentru georeferenţiere şi selectarea imaginii care va fi
georeferenţiată

Pentru a putea fi georeferenţiată prin raportare la o harta deja georeferenţiată
trebuie să se găsească puncte comune ı̂ntre cele două. Aceste puncte pot fi
intersecţii de drumuri sau colţuri ale unor clădiri, sau copaci, movile, stâlpi
izolaţi. Trebuie să se acorde o mare atenţie selecţiei punctelor comune şi să se
ţină cont de faptul că ı̂ntre cele două reprezentări este posibil un decalaj de
timp ı̂n care obiectele de pe suprafaţa terestră să se fi modificat (e posibil să fi
apărut clădiri noi, să se fi modificat trama stradală, etc.). De aceea rezultatele
bune prin această metodă presupun o experienţă anterioară de lucru şi intuiţie.
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După ce s-a ales imaginea care va fi georeferenţiată este necesar ca aceasta să
fie reprezentată ı̂n acelaşi cadru cu cea georeferenţiată pentru a facilita ”lega-
rea” punctelor comune. Pentru aceasta, după ce se face zoom in pe imaginea
georeferenţiată, se face click pe butonul Georeferencing din bara de unelte.
Opţiunile care apar ı̂n acest meniu se aplică doar imaginii selectate ı̂n câmpul
Layer de alături. Se alege Fit to Display (fig. 2.35), iar imaginea va fi ”mutată”
ı̂n acelaşi cadru cu cea georeferenţiată (fig. 2.36).

Fig. 2.35: Bara de unelte pentru georeferenţiere şi selectarea opţiunii Fit to
Display

Fig. 2.36: Suprapunerea imaginii negeoreferenţiate ı̂n acelaşi cadru cu cea
georeferenţiată

Dacă este cazul, tot ı̂n bara de unelte Georeferencing se găsesc şi butoane pentru
rotirea, redimnensionarea sau mutarea imaginii ı̂ntr-o poziţie mai bună (fig.
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2.37).

Fig. 2.37: Bara de unelte pentru georeferenţiere şi opţiunile de mutare, redi-
mensionare şi rotire a imaginii

În acest moment imaginile sunt suprapuse aproximativ, dar doar vizual. Pen-
tru a stabili punctele de coordonate cunoscute de pe imaginea negeoreferenţiată
utilizatorul selectează mai ı̂ntâi punctul pe acea imaginea apoi selectează punc-
tul corespondent de pe imaginea georeferenţiată. În felul acesta aplicaţia va
prelua coordonatele acelui punct de pe imaginea georeferenţiată. Aceasta se
face cu butonul Add Control Points (fig. 2.38). Cu acest buton activat, curso-
rul mouse-ului devine o cruce. Se face zoom in către punctul ales pe imaginea
negeoreferenţiată şi se face click pe acel punct. În acest moment aplicaţia a
reţinut coordonatele pixelului (pe care l-a marcat cu o cruce verde) pe imagi-
nea negeoreferenţiată (cele din sistemul intern al imaginii) şi ”aşteaptă” de la
utilizator specificarea coordonatelor ı̂n sistemul de coordonate ı̂n care se face
georeferenţierea (fig. 2.39). Aceasta se face cu un al doilea click, cu acelaşi
buton activat, pe imaginea georeferenţiată, ı̂n punctul corespunzător12. Acesta
va fi marcat cu o cruce roşie şi va fi considerat primul punct de coorodonate
cunoscute de pe imaginea negeoreferenţiată (fig. 2.40).

Fig. 2.38: Bara de unelte pentru georeferenţiere şi butonul Add Control Po-
ints care permite selecţia punctelor de coordonate cunoscute de pe imaginea
negeoreferenţiată

12 Pentru a face vizibilă harta georeferenţiată se debifează din tabel imaginea
negeoreferenţiată (similar cu Google Earth), care ”stă” deasupra
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Fig. 2.39: Selectarea punctului de coordonate cunoscute pe imaginea
negeoreferenţiată

Fig. 2.40: Selectarea punctului de coordonate cunoscute pe harta georeferenţiată
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Rezultatul este vizibil imediat: ca urmare a legăturii dintre cele două puncte,
imaginea negeoreferenţiată s-a deplasat astfel ı̂ncât cele două puncte să se su-
prapună exact (fig. 2.41).

Fig. 2.41: Primul punct de coordonate cunoscute marcat pe imaginea
negeoreferenţiată.

În mod analog se procedează cu restul punctelor, până se obţin cel puţin 4,
distribuite uniform şi pe o suprafaţă cât mai mare din imagine (fig. 2.43).
Aceste puncte se salvează ı̂ntr-un tabel similar cu cel din Global Mapper, care
este accesibil cu click pe butonul View Link Table (fig. 2.42). În acest tabel
oferă şi o primă modalitate de verificare a acurateţii georeferenţierii: ı̂n coloana
Residual se dau valorile de eroare exprimate ı̂n unitatea de măsură a sistemului
de coordonate (̂ın cazul nostru metri). După cum se observă ı̂n fig. 2.43, pentru
nici un punct valoarea aceasta nu este 0, iar acest fapt este normal pentru modul
ı̂n care s-a realizat georeferenţierea. Condiţia este ca valoarea residuală să nu
depăşească totuşi 4-5 m, pentru ca georeferenţierea să se considere acceptabilă.
Dacă se ı̂ntâmplă acest fapt, măsura de remediere este să se şteargă din puncte
şi să se aleagă altele, sau aceleaşi, dar cu atenţie mai mare. Punctele se şterg
din acest tabel cu butonul marcat cu X de pe marginea din dreapta a tabelului.
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Fig. 2.42: Bara de unelte pentru georeferenţiere şi butonul View Link Table care
permite vizualizarea coordonatelor punctelor de control.

Fig. 2.43: Punctele de control şi valoarea erorii pentru fiecare punct ı̂n parte

Imaginea este georeferenţiată şi tot ce mai trebuie făcut este să se salveze
informaţiile de georeferenţiere ı̂ntr-un fişier WORLD. Aceasta se face cu click
pe Georeferencing>Update Georeferencing, iar fişierul creat va avea aceeaşi de-
numire ca a imaginii dar extensia .jgw (̂ın cazul nostru topoGE.jgw).
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Pentru vizualizare şi verificare, se ı̂ncarca imaginea din nou ı̂n Google Earth, ı̂n
acelaşi mod care s-a descris la secţiunea 2.2. Rezultatul ar trebui să fie similar
cu cel din fig. 2.44

Fig. 2.44: Vizulizarea ı̂n Google Earth a imaginii georeferenţiate, pentru verifi-
care
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Capitolul 3

Transformarea
coordonatelor ı̂n diferite
sisteme de proiecţie

O situaţie des ı̂ntâlnită ı̂n lucrul cu date spaţiale este aceea că pot exista seturi
de date ı̂n sisteme de proiecţie diferite, din cauză că provin din surse diferite.
Este nevoie ca aceste date, fie ı̂n model raster, fie ı̂n model vector, să fie re-
proiectate. Se modifică aşadar sistemul de proiecţie ı̂n care este georeferenţiat
setul respectiv pe baza unei transformări matematice1. La nivel mondial există
foarte multe sisteme de coordonate definite pentru diverse regiuni. Conver-
sia ı̂ntre aceste sisteme de coordonate se realizează prin raportare la sistemul
WGS84: datele se transformă mai ı̂ntâi din sistemul local ı̂n sistemul WGS84
apoi din WGS84 ı̂n sistemul dorit. De aceea, practic, problema transformărilor
de coordonate se rezumă la transformarea dintr-un sistem oarecare (̂ın cazul
nostru unul din sistemele care sunt ı̂n vigoare ı̂n ţara noastră) ı̂n WGS84. Pen-
tru exemplificare vom detalia o transformare a unui set de date din proiecţie
Stereo 70 ı̂n proiecţie UTM pe datum WGS84. Din experienţă s-a observat că
o astfel transformare, cu foarte bună acurateţe, este implementată ı̂n aplicaţia
Global Mapper. După cum s-a arătat şi ı̂n secţiunea 1.2.2, pentru proiecţia
Stereo 70, ı̂n Global Mapper există se pot defini practic 2 datum-uri: DEALUL
PISCULUI 1970 şi S42-ROMANIA. Pentru primul, programul aplică un algo-
ritm de trasnformare către WGS84 cu 3 parametri, iar pentru al doilea cu 7
parametri, rezultând astfel o transmare mult mai exactă.

Concret, transformarea este foarte simplu de realizat. Se ı̂ncarcă setul de date
(cu mare atenţie la definirea sistemului de proiecţie), se schimbă sistemul de
proiecţie apoi se exportă setul de date ı̂n acelaşi format, sau ı̂n format diferit,
dacă e cazul2. Pentru exmplificare vom folosi harta georeferenţiată ı̂n secţiunea
2.1. Aceasta este ı̂n proiecţie Stereo 70, şi ı̂n format .jpg. O vom transforma ı̂n

1Detaliile acestor transformări nu intră ı̂n competenţa autorului şi nu vor fi prezentate aici.
Pentru un utilizator obişnuit nici nu este nevoie de acestea, fiind suficientă ı̂nţelegerea la nivel
conceptual a operaţiei

2 Acesta este al doilea mare atu al aplicaţiei Global Mapper, pe lângă cel al transformării
exacte: suportă un număr foarte mare de formate de date şi asigură conversia ı̂ntre ele.
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proiecţie UTM pe datum WGS84 şi ı̂n format .tif3.

Se deschide aplicaţia Global Mapper şi se ı̂ncarcă fişierul cu harta respectivă
(topo georef.jpg), ı̂n modul arătat ı̂n secţiunea 2.2. Se aleg sistemul de proiecţie
Stereo 70 şi datum-ul S42(ROMANIA) (vezi fig. 2.10). Transformarea ı̂n alt
sistem de coordonate se realizează din meniul Tools>Configure... (fig. 3.1).

Fig. 3.1: Accesarea meniului de configurare

În fereastra care apare, Configure se pot executa numeroase modificări ale me-
diului de lucru din Global Mapper. Aceastea sunt organizate pe secţiuni şi
accesibile din tab-uri: General, Vector Display, Area Style, etc. Cea care ne
interesează este secţiunea Projection. Aici sunt informaţiile despre sistemul de
proiecţie introduse la ı̂ncărcarea setului de date: proiecţie Stereo 70 şi datum
S-42(ROMANIA). În câmpurile respective se alege noul sistem de proiecţie: ı̂n
câmpul Projection: UTM, ı̂n câmpul Zone: 35 (24◦ - 30◦ - Northern Hemis-
phere)4, iar ı̂n câmpul Datum: WGS84 (fig. 3.2). Modificarea sistemului de
proiecţie va determina modificarea modului de reprezentare a hărţii. Aceasta
va apărea ca ı̂n fig. 3.3.

Exportul imaginii se realizează cu File>Export Raster and Elevation Data >Ge-
oTIFF..., apoi se aleg opţiunile (de exemplu, ca ı̂n fig. 3.4). Se aleg locul
şi denumirea (de exemplu topo georef UTM.tif), iar aplicaţia va crea fişierul
WORLD cu extensia .tfw.

3 Este aceeaşi abordare ca ı̂n secţiunea 2.2, cu deosebirea că acum vom realiza explicit
transformarea ı̂ntre cele două sisteme de coordonate

4 Acesta este fusul proiecţiei UTM (vezi secţiunea 1.2), şi dacă iniţial sistemul de proiecţie
a fost ales corect, aplicaţia selectează fusul potrivit pe baza coordonatelor setului de date.
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Fig. 3.2: Noul sistem de coordonate ı̂n care se va reprezenta harta topografică

Fig. 3.3: Harta reproiectată ı̂n UTM-WGS84
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Fig. 3.4: Opţiuni de export ı̂n format .tif
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